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Qslip - User Guide - First Run of Qslip

1.  The 60-day trial period is commenced. 
2.  If you have purchased a license for Qslip, select "License Qslip" from the "Help" menu to enter your License Name 

and Key. After the trial period expires, Qslip will still function normally, but printed output will be partially obscured 
by a watermark. Entering a valid Qslip license will remove the watermark. 

3.  Qslip prompts for a file to open. 
4.  If you have already exported a deposit file from a supported accounting application such as QuickBooks, you may 

open it. Otherwise, you can open a sample from the "..\Qslip1\Samples" folder, or select "New" from the "File" 
menu (or click the "New" button) and create a new deposit. 

5.  Qslip opens ready to use: 
 
This screenshot shows one of the samples opened which uses a deposit slip format that includes a built-in 
background style for printing complete deposit slips on plain paper. 
 



 
6.  Set the layout options for your deposit slip format or use a built-in complete format. 
7.  Set layout positions for your deposit slip format or use a built-in complete format. 



8.  Test printing a deposit slip. 

Back to Table of Contents
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Qslip - User Guide - Importing
1.  Importing from QuickBooks (all desktop versions) 
2.  Importing from QuickBooks Online 
3.  Importing from other applications 
4.  Optimizing the import process (includes command-line parameters) 
5.  Import errors 
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Qslip - User Guide - User-Entered Deposits
 

 Use this method when you are not importing deposit information from another application.
 

1. Select "New" from the "File" menu, or click the  

button.

2. The Deposit Date is set to the current date - you may 
change this.

3. Set the Currency Total (paper money).

4. Set the Coin Total.

5. Enter Cash Back (optional).

6. Change the Slip Format (if necessary)

 



7. Enter checks.

If the customer list feature is enabled, customer name and 
bank number will be auto-filled based on previous entries.

●     Use the TAB key to move across through fields. 
●     Use the ENTER key to move down the items in a 

column. (In Preferences, you can set the ENTER key to 
act the same as TAB key.) 

●     Pressing CTRL+INSERT will insert a blank row above 
the current row. 

●     Pressing CTRL+DELETE will delete the current row. 
●     Checkboxes above columns determine which columns 

are active when TABBING through fields to help speed 
data entry. 

●     Clicking the column headers will sort the list based on 
the column. 

 

8. Click "Preview" to verify the deposit information.

9. Print the deposit slip.

Back to Table of Contents

Copyright Qtools Software - © all rights reserved

QuickBooks is a registered trademarks of Intuit, Inc.



Back to Table of Contents

Qslip - User Guide - Slip Formats
 

Slip Formats contain all the information required to print the deposit information onto a specific deposit slip style and layout. There 
are many formats included with Qslip, which can be used as-is or copied and modified.

 

1.  Setting, Creating & Editing Slip Formats 
2.  Setting Layout Options 
3.  Setting Layout Positions 
4.  Testing layout and options settings 

●     Example: Setting up custom slip formats for 2 bank accounts and 2 printers, and assigning them to import 
filenames. 
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Qslip - User Guide - Using Slip Backgrounds

●     Built-in Backgrounds are used to print complete deposit slips. The background prints the generic part of a 
deposit slip, such as lines and labels. 

●     Image Backgrounds allows JPEG image files to be printed on the slip. 

 

Slip Background tab:

Built-in Backgrounds:

At this time there are two Styles available:

●     Style A: Vertical business style, 2-sided. Use this style to 
support a large number of deposit items. 

●     Style B: Horizontal style, 1-sided. Use for deposits with 
18 or less items. 

The background elements of each style will automatically 
adjust to many modifications to the slip format. 

If you wish to modify one of the Built-in slip formats, we 
recommend using the "Create New or Copy" button to make 
a copy on which to make changes. 

A color can be assigned to the background to print the 
elements lighter on black & white printers, or in color. Please 
check with your bank.

Left and Top adjustments will move all background elements 
relative to the deposit information. Normally they should be 
left at Zero.

See the Depositor Options setup page for more information about printing your bank and account information on the deposit slip.

Image Background from File:



JPEG format image files can be used as a complete background using the "Fit to Slip Size" option; or as a logo, etc. Use the 
browse "..." button to set a path to a JPEG file. Use the Left and Top values to position the upper-left corner of the image.

 Built-in Format Specifications

Click an image to view full size
BACKFRONTBuilt-in Format A:

Uses Style A background.

3 3/8 x 8 1/2 inches.

Vertical business style with typical fields.

2-sided. 

Cash back capable.

Maximum 74 checks (30 front, 44 back)

Configured to print to bottom edge of letter size (8.5x11 inch) paper for 
easy printing and cutting. Will auto-duplex on capable printers.



 

BACKFRONTBuilt-in Format A - All Fields:

Uses Style A background.

3 3/8 x 8 1/2 inches.

Vertical business style with all fields.

2-sided.

Cash back capable.

Maximum 70 checks (26 front, 44 back)

Configured to print to bottom edge of letter size (8.5x11 inch) paper for 
easy printing and cutting. Will auto-duplex on capable printers.

 



BACKFRONTBuilt-in Format A - 100 items:

Uses Style A background.

3 3/8 x 8 1/2 inches.

Vertical business style with typical fields.

2-sided.

Cash back capable.

Maximum 100 checks (40 front, 60 back)

Configured to print to bottom edge of letter size (8.5x11 inch) paper for 
easy printing and cutting. Will auto-duplex on capable printers.

 



Built-in Format B:

Uses Style B background.

8 1/2 x 3 1/2 inches.

Horizontal business style with typical fields.

1-sided.

Cash back capable.

Maximum 18 checks

Configured to print to top edge of letter size (8.5x11 inch) paper for easy printing and cutting.

 

Built-in Format B - All Fields:

Uses Style B background.

Horizontal business style with all fields.

1-sided.

Cash back capable.

Maximum 15 checks

Configured to print to top edge of letter size (8.5x11 inch) 
paper for easy printing and cutting.
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Qslip - User Guide - Printing
1.  Printing complete deposit slips on plain paper 
2.  Printing on pre-printed deposit slips 
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Qslip - User Guide - Saving Deposit Info to File

Saving a deposit slip in Qslip saves it to a Qslip formatted file which can be loaded back into Qslip. This allows 
you to save any changes you have made to a deposit. 

●     "Save" will save without prompting (unless the deposit is new and unnamed) to the current filename and 
location. 

●     "Save As..." will allow you to name the file and set its location. 
●     When the file is re-opened, any editing restrictions will still be in effect depending on whether the deposit was 

an import from an accounting application, or created in Qslip. 
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Qslip - User Guide - Customer List Feature
The purpose of the customer list feature is to speed data 
entry. It is automatically maintained by Qslip, so you 
shouldn't need to worry about it. However, the tab page 
shown here allows you to edit and purge the list if you 
choose, as well as import from an external list.

To delete a single entry in the list, select it and then press 
CTRL+DELETE.

The import option is useful under two circumstances:

●     If you import deposit information and you have an 
existing list of customers and bank numbers. By 
importing this customer list, the bank number will be 
inserted by Qslip for each customer, so you won't have 
to enter the bank number in the memo field when 
receiving payments in QuickBooks. (Please note: even 
without using this customer import, you only need to 
enter bank numbers in QB the once for each customer, 
since they will be stored in Qslip for subsequent use). 

●     If you manually enter deposit information into Qslip to 
create deposits, importing a customer list will speed data 
entry on first use of a customer in Qslip. 

The import file must have tab-delimited columns, and a header as row 1 with a column named "customer" and optionally a 
column named "bankno" -- all other columns will be ignored. The QB Customer List export, in IIF format is an acceptable format.

You can disable the customer list feature in preferences.

Back to Table of Contents
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Qslip - User Guide - Setting Preferences
General Preferences

 

Customer List Preferences



 

Import Files Preferences





 

Security Preferences

 

Data File Preferences
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Qslip - User Guide - Utilities
Make Deposit Editable.

Imported deposits are, by default, set to mostly read-only. Only the date 
and some values (e.g. check and bank numbers) can be edited. This is 
to maintain consistency with the source application data.

If you must edit locked elements of an imported deposit, select the 
"Make Deposit Editable" item on the Edit menu.

 

Find Samples folder:

Provides the option to have the next open file dialog point to 
the sample deposit files included with Qslip.

Convert Deposit Files to CSV:

Converts deposit files saved in Qslip to reports in comma-
separated format. Allows selection of multiple files to 
combine. Creates 2 files -- a detailed transaction file, and a 
summary by customer. Can be opened in Excel for further 
formatting and printing. 

Backup Slip Formats data file:



Creates a copy of the file that holds Slip Formats data and 
provides a dialog to name and save to your desired backup 
location.

Restore Slip Formats data file:

Overwrites the existing Slip Formats data file with the 
selected file. It must be a properly formatted file, such as a 
previous backup.

Add Slip Formats from file:

Adds Slip formats to the existing (target) Slip Formats data 
file from the selected source file. It must be a properly 
formatted file, such as a previous backup, or a file from 
another user. Only Slip Formats with names that differ from 
Formats in the target file will be added. Same named formats 
are ignored, with no changes made to them in the target file.

Backup Customer List data file:

Creates a copy of the file that holds Customer List data and 
provides a dialog to name and save to your desired backup 
location.

Restore Customer List data file:

Overwrites the existing Customer List data file with the 
selected file. It must be a properly formatted file, such as a previous backup.

 

Back to Table of Contents
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Qslip - User Guide - Command-Line Parameters

Passing files and options on command line. Using this feature, a Windows shortcut can be created that will launch 
Qslip and load the file. Just add a shortcut to the Qslip executable including the filename to open (put a space 
between the 2 paths: ie. "C:\Program Files\Qtools\Qslip2\Qslip.exe C:\Data\Qbooks\Deposit.txt") 

This is most useful if you regularly print to more than one deposit slip format. By using the appropriate "Filename 
that will have this format assigned" setting in Qslip when exporting the deposit, you can setup shortcuts to each 
deposit export file (be sure to create an export file before trying to create the shortcut).

This feature can also be used to run Qslip from another application and automate its printing process using the 
switches. See Importing from other applications for information on generic import formats that can be passed to 
Qslip.

The Slip Format can be set using the second parameter. This overrides any Slip Format assignment based on the 
filename. This override lasts for the entire Qslip session, so you must close Qslip to clear this override setting. If 
this causes problems use the filename format assignment method instead.

 

Parameters:

1. Deposit data filename (full path required).

2. Deposit slip format name. (optional)

Switches: (must be after above file references. All are optional.)

-autoprint Sends loaded slip to printer.

-autoprintsilent Closes Qslip after printing, and suppresses most warning dialogs.

-nocustlist Disables Qslip customer list usage.

-copies=n Sets number of copies to print.

-printreport Prints deposit report instead of deposit slip.



Place quotes around any parameter that contains spaces.

Example:

"C:\Program Files\Qtools\Qslip2\Qslip.exe" "C:\Program Files\Qtools\Qslip1\Samples\depBD81.TXT" 
"Deluxe BD43" -autoprintsilent

Back to Table of Contents
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*** REVISION HISTORY for Qslip ***

v2.50 (1/17/13):
        -New Feature: Built-in deposit slip backgrounds can be used to print
         complete deposit tickets, instead of pre-printed deposit slips.
        -New Feature: A JPEG image file can be used for either the background for
         the entire slip, or for a logo or other graphic. See the new
         "Slip Background" tab for settings.
        -New Feature: For printers that support duplexing (auto 2-sided printing),
         there is now the option to select Duplex Head-to-Head or Duplex
         Head-to-Toe printing. This is only recommended when printing to full-size
         sheets, since small deposit slips may jam in auto-duplexers. The setting
         is stored with each slip format.
        -New Feature: Printer resolution can now be set and stored with each
         slip format.
        -New Feature: Depositor Options for Account Number and Other Text can now
         be rotated 90 degrees.
        -New Feature: Depositor information can be copied from other slip formats.
         Use button next to Name field. 
        -New Feature: Imported deposits can be made fully editable by selecting
         the "Make Deposit Editable" item on the Edit Menu.
        -New Feature: Support for importing deposits from QuickBooks Online
         Deposit Detail report.
        -New Feature: Preference setting for display of cash back alert.
        
v2.21 (9/17/12):
        -New Feature: Utility added to the "File|Utilites" menu, providing
        capability to add additional Slip Formats from a file. Useful for sharing
        slip formats.

v2.20 (9/12/12):
        -New Feature: Four utilities added to the "File|Utilites" menu, providing



        backup and restore of Slip Formats and Customer List data files. Useful
        for backup purposes, or when migrating Qslip to a new computer.
        -Minor changes to support Windows 8.
        -Windows 2000 is now minimum supported operating system.
        Windows 95/98/Me/NT4 no longer supported.

v2.10 (8/18/09):
        -New Feature: Payment Method column added to Checks Grid displays
        imported value or allows entry on user-entered deposits. Value is now
        stored in Qslip format files when saving a deposit. Useful for users
        that wish to distinguish between various payment methods such as CHECK,
        MONEY ORDER, TRAVELERS CHECK, etc. When entering checks manually into
        the Checks Grid, the method will default to "Check" if left blank.
        -New Feature: Text cut off by narrow columns in the Checks Grid now
        display the full text in a hint bubble when mouse pointer is over cell.
        -New Feature: Added warning dialog when attempting to enter more checks
        than supported by current deposit slip format.

v2.03 (4/10/09):
        -New Feature: Option to select which side of a 2-sided deposit slip
        to print (Both, Side 1 or Side 2).
        -New Feature: New preference setting to "Load last saved file on
        startup." (default setting is still "Load last imported file on startup")
        -Bugfix: Generic CSV import was not accepting files with quoted headers.
        
v2.02 (5/31/07):
        -New Feature: Deposit Slip side 1 and side 2 print orientation
        can now be set independently.
        -New Feature: QuickBooks Comma-Separated file format (*.csv) is
        now supported.
        -New Feature: Option to select whether zero amounts print "0.00"
        or blank (previous behavior and default is "0.00"). See the "Printer &
        Formatting" tab page of a slip format to set this option.



        -New Feature: Previously, Qslip would display a warning dialog
        for every item in an import file with a payment method other than CASH
        or CHECK. Now a user editable list is available to add payment methods
        that will be treated as checks ("Money Order" is in this list by
        default), so no warning is displayed. In addition, now even when
        multiple items are found that require warning, only one warning dialog
        is issued at the end of the import. To use this feature, see the new tab
        page named "Payment Methods" on the "Import Files" tab page of the
        Preferences dialog (found on the File menu).
        -New Feature: Actual imported Payment Method can now optionally
        be printed on Deposit Slip next to amounts (see new CheckBox on Slip
        Format settings).
        -New Feature: Capability added to set the location of the Slip
        Format Settings and Customer List data files. This can be used to keep
        these files in location of your choosing such as a different folder or
        on a server. You can also use this feature to share these files among
        multiple installations of Qslip, however Qslip is not designed for
        simultaneous multi-user access and changes to these files may be lost
        if used simultaneously. To use this feature, see the new tab page named
        "Data Files" on the Preferences dialog (found on the File menu).
        -Bugfix: "Save As..." for deposit data was not correctly
        updating the newly saved filename. Subsequent saves would still write
        to the original filename.
        -Bugfix: Fix "index out bounds" error if a deposit file was
        opened while another deposit file was already open displaying the
        checks grid, and print preview showing.

v2.01 (2/13/07):
        -Bugfix: Entering values into layout position dimensional controls
        was not working properly after 2.00 release.
        
v2.00 (1/8/07):
        -Changes to support Windows Vista (which also improve security



        on Windows XP and Windows 2000).
        -New Feature: Dynamic preview of changes to deposit information
        and slip format settings. Preview displays at startup if it was open at
        previous Qslip exit.
        -New Feature: Checks and Customer Lists can now be sorted by
        clicking on column header.
        -New Feature: Tech Support Info Tool on Help menu. Collects
        application and system information to email to Qtools support to aid
        in troubleshooting.
        -New Feature: Detection and warning if a second instance of
        Qslip is started. If you run concurrent instances of Qslip, deposit
        slip formats and customer list data will be overwritten by each
        instance. Changes made in one instance will be lost if the other
        instance is closed after it.
        -If the Windows DPI is changed, such as setting to use Large
        Fonts, Qslip windows now size correctly.
        -Many small interface fixes and improvements.
        -Bugfix: The first time some dialogs appeared (New Slip Format,
        Preferences, etc.) they could be out of view at smaller screen
        resolutions, which would make Qslip appear to lock-up. These dialogs
        are now always centered on Qslip window.
        -Printed output is now partially obscured if trial period has
        expired and a valid license key has not been purchased and entered.
        -Files that store slip formats (slips.dat), customer list
        (custlist.dat), and license information (Qslip.qlic) are now located
        in the common application data folders available to all users. These
        files should be backed up regularly.
        On Windows versions prior to Vista (XP, 2000, etc.):
        \Documents and Settings\All Users\Application Data\Qtools\Qslip2
        On Windows Vista:
        \ProgramData\Qtools\Qslip2



v1.60 (9/12/06):
        -Bugfix: Printing was failing with error message "Divide by Zero"
when printing to some printers when certain other printers are set as the
Windows default printer. 

v1.59 (8/1/06):
        -Bugfix: Save As dialog was not recalling last saved folder. 

v1.58 (6/12/06):
        -New feature: Utility to convert deposit files saved in Qslip to
comma-separated format. Allows selection of multiple files to combine.
Creates 2 files -- a detailed transaction file, and a summary by customer.
Located on the Utilities sub-menu of the File menu.

v1.57 (3/18/06):
        -Bugfix: Bank Account name was not being saved or read correctly
for deposits created in Qslip (imported deposit files not affected).

v1.56 (10/12/05):
        -New feature: Option to print deposit item line numbers on
report. (see preferences)
        -Bugfix: Allow blank BankNo entry - now entering a space
character will prevent auto-fill of customer's bankno from customer
list.

v1.55a (8/19/05):
        -Bugfix: Manual checks entry was limited to number of visible
lines in data entry window (v1.55 only).

v1.55 (8/15/05):
        -New feature: Option to disable column(s) to speed check entry.
        -New feature: Option in preferences to use [ENTER] key to tab
through fields when entering checks.



        -New: For users not importing data, when Qslip is first started
it now recalls the last Slip Format used in previous session.
        -Bugfix: Fixed issues in dropdown boxes which first appeared
in version 1.50.
        -Bugfix: Fixed Generic CSV import errors if first or last column blank.

v1.51 (4/21/04):
        -New feature: Option to itemize cash line items on deposit report
for imported deposits. (see Preferences).

v1.50 (3/6/04):
        -Minor updates to better handle folder searching for
recent QB versions.
        -Updated installer for better WinXP compatibility.
        -After installation and first run by a user with Power
User or Admin rights, can now be run by users with "User" group rights.

v1.40 (12/12/03):
        -New feature: Generic CSV and TAB import formats added.
        -New feature: Add additional command line capabilities
to set Slip Format, automatically print, etc.
        -Bugfix: Currency, Coin and Cash Back edit controls
gave floating point error on entry if displaying a thousands
separator.
        -New: Deposit Report font size for header and items
can be set independently.

v1.33 (1/12/03):
        -Handle change in deposit file format for QB 2003.
        -Made Bank Account name editable.
        -Store customer names even if Bank No. is blank.

v1.30 (2/28/01):



        -New Feature: Add Depositor Info to printing
options - Name and Address, Account#, Bank and Address,
custom Other Text.
        -New Feature: Preferences option to remove split
check identifier "p" from check numbers on QB import.
Default setting is OFF.
        -New Feature: Preferences option of whether to
combine split checks. Default is ON.

v1.20 (6/21/00):
        -New Feature. Support added for QuickBooks native
deposit slip format.
        -New Feature. Multi-column deposit slip support.
        -New Feature. Printable deposit report.
        -New Feature. Cash Back amount is now printed
on deposit slip.
        -New Feature. Qslip maintained customer list
to speed data entry: recalls bank numbers on imported
deposits, and performs auto-fill of customer name and
bank number on user-entered deposits.

v1.18 (3/6/00):
        -Bugfix. Occasional Access Violation error when
closing Preferences dialog.
        -Bugfix. "Duplicate File Load Name not allowed"
error sometimes inaccurate.
        -New Feature. Stronger validation of "slips.dat"
file and data.

v1.17b (1/8/00):
        -Bugfix. Removed bug-checking code left from
trouble shooting previous bug.



v1.17a (1/8/00):
        -Bugfix. In rare cases an "invalid floating point
operation" error would abort printing or previewing a
deposit slip. This only affected v1.17.

v1.17 (12/8/99):
        -New Feature. Any combination of Customer Name,
Memo, Bank # and/or Check # can be printed on the slip.
        -New Feature. Filename can be passed to Qslip
on command line.
        -Bugfix. Y2K error if a pre-2000 deposit slip
opened on or after 1/1/2000.
        -New Feature. Allow Max Checks to be set to zero
to enable printing on back of deposit slip only.
        -Bugfix. Crashed if system had no default printer.

v1.16 (2/22/99):
        -Bugfix. The security setting in preferences
"delete last import file on exit" will now only delete
valid files that Qslip can open. Before the fix,
whatever file that was last attempted to be opened
using the Qslip File Open dialog would be deleted
on exit (if the preference was enabled by user; the
default setting is disabled).
        -New Feature. Utilities menu item to set File
Open dialog to samples folder.
        -New Feature. Cash Back editable on user-created
deposit slips, plus option in preferences to disable or
enable this feature.
        -New Feature. Option in preferences to start
with a new blank deposit on startup, or open last viewed
deposit file.



v1.15 (1/1/99):
        -New Feature. QB99 support added. Accomodates
both 2 and 4 digit years in the deposit date field,
and handles the new Cash Back option.
        -New Feature. Support added for tab-delimited
QuickBooks export files.

v1.14 (10/27/98):
        -Bugfix. Import files with no check number
values could fail with an "Access Violation..." error.

v1.13 (10/15/98):
        -Bugfix. Cancelling the "New Format" dialog
was changing the current format to the first one in list.
        -New feature. The "slips.dat" file, which stores
the slip formats, is now not overwritten when doing an
upgrade over a current install. Instead, a file called
"newslips.dat" is placed in the program directory. The
first time Qslip is run, this file is merged with any
existing "slips.dat" file, and any formats with same
name are not merged. This allows users to upgrade without
losing any new or modified slip formats, and also will
allow additional slip formats to be released and
installed separately.
        -New feature. An option to print Check Numbers
instead of Bank Numbers on the deposit slip.

v1.12 (8/29/98):
        -Bugfixes.

v1.11 (8/25/98):
        -Bugfixes and new features.



v1.01 (7/23/98):
        -First release.
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Qslip - User Guide - Known Problems & Workarounds
1.  Under Windows 2000 & XP, Qslip must be installed by a user with administrator rights. Windows Vista/Win7/Win8 will request and 

requires elevation to administrator rights for installation. After installation, Qslip can be run with standard user rights. 
2.  Multiple users attempting to run the Qslip application from a network drive will receive a "Hardware has changed - please re-enter 

your registration key" message. Although Qslip works fine in a network environment, and can access files anywhere on the network, 
the application itself must be installed on each workstation that will run it. 
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Qslip - User Guide - Printers List & Fixes

Most printers that work with Windows should work fine with Qslip. This list is meant to aid trouble-shooting.

Printers Known to Work with Qslip

1.  Brother HL-5340 
2.  Canon BJC-7000, BJC-5000, i9900 
3.  Epson ActionLaser 
4.  Epson EPL-6000 
5.  HP 5L series 
6.  HP 6L series 
7.  HP 820C series 
8.  HP 4000 series 
9.  Lexmark Color Jetprinter 1020 
10.  Lexmark E210 

Printers that have problems outputing from Qslip

1.  HP 722c - bypass tray feed problem reported by some users (use main tray) 
2.  HP 895cse - bypass tray feed problem reported by some users (use main tray) 
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Qslip - User Guide - Setting Layout Options
 

Select the Basic Options tab.

Select the fields you want printed on your deposit slips 
under "Print on Slip." Unchecked items will not be printed.

Choose the fonts. The amount font must be a TrueType, 
fixed-width font in order to print properly, such as "Courier 
New."

Set the font sizes (in points) that best fit your deposit 
slip format.

These positions for these fields are set on the Layout & 
Add'l Layout tab pages.

 



If the deposit slip is set as 2-sided, there will be additional 
items to set.

The positions for these fields are set on the Side 2 
Layout tab page.

 



Select the Depositor Options tab.

Set which fields to print using the check boxes.

Edit the field values for you or your company, and your 
bank. (Click the "..." button next to the Name field to copy all 
the fields data from another Slip Format)

Make font and font size changes, if necessary.

This information will print on the deposit report regardless of 
the "Print on Slip" setting.

The positions for these fields are set on the Depositor 
Layout tab page.

Built-in Background Styles used for printing complete 
deposit slips use the OTHER TEXT field for encoding the 
MICR line for transit number and account number.

Use an existing deposit slip as a guide, or check with your 
bank for their required format.

Use the letters a, b, c , d to print the MICR symbols.

 

(Since many banks now include optical scanning of deposit slips, the built-in styles that print complete deposit slips should be 
accepted by your bank. However, some banks still require printing with magnetic ink. If your bank rejects your deposit slip due to 
this you may want to consider purchasing magnetic toner for printing your deposit slips. Or use Qslip to print onto a conventional 
pre-printed deposit slip.)



 

Select the Printer & Formatting tab.

Set the extra character spacing for amounts. This 
is primarily used to align digits with the pre-printed boxes or 
columns on some deposit slip formats. (0 is default spacing, 
100 is twice normal, 200 is 3 times normal, and so on).

(enabling Decimal Point and/or Thousands Separator will 
disable extra character spacing.)

Select the printer you wish to print your deposit slips.

Set the printer resolution (optional).

Set the orientation if necessary.

Set the overall Horizontal and Vertical alignment. 
This will move the entire deposit info image left-right, up-
down. This also lets you leave your printer set to standard 
8.5" x 11" paper, which allows printing closer to some edges 
of the deposit slip.

This setting is very important when you want to position your 
deposit slip image on your pre-printed slip. It moves all the 
fields equally. Use it to offset the printed image to the 
position your printer feeds your deposit slip. 

Slip Formatting: 

Print Decimal Point: If your pre-printed deposit slip does not include a vertical line in the items section separating dollars 
and cents, enable this feature. For built-in complete deposit slips, you can choose either setting.

Print Thousands Separator: All amounts will display a thousands separator (e.g. 9,999.99).

Print Zero (0.00) Amounts: For any values that are zero, when this option is checked 0.00 will be printed, if unchecked 
nothing will be printed (blank).

Print Currency Symbol on Total: The Deposit Total and Rotated Deposit Total will print a currency symbol. For pre-
printed deposit slips, disable if a currency symbol is pre-printed. For built-in complete deposit slips, you can choose either setting, 
but check with your bank.



 

If the deposit slip is set as 2-sided, the Side 2 character 
spacing and Alignment controls will be enabled.

 

Next: Set the Layout Positions your deposit slip layout.

Back to Slip Formats
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Qslip - User Guide - Set Layout Positions

Grab a ruler and a blank pre-printed deposit slip 
●     For best results, make all measurements to the nearest 32nd of an inch. 
●     Skip any items not used on your slip format (eg. Checks Total) -- they will appear grayed-out. 
●     You may enter decimal or fractional amounts in the measurement edit controls (decimals will be converted to 

the nearest fraction). 

 

Layout:

These items reference fields enabled on the Basic 
Options tab page.

Set the value for Number of Checks to the exact number 
of check lines on the front of the deposit slip.

Measure the overall width and height of the slip, and enter 
values in Slip Width and Height.

Set the Horizontal Positions: Measuring from the left 
edge of the slip, to the points marked in blue, enter the 
corresponding values.

Set the Vertical Positions: Measuring from the top 
edge of the slip, to the points marked in red, enter the 
corresponding values.

 



Add'l Layout:

These items reference fields enabled on the Basic 
Options tab page.

Set the Horizontal Positions: Measuring from the left 
edge of the slip, to the points marked in blue, enter the 
corresponding values.

Set the Vertical Positions: Measuring from the top 
edge of the slip, to the points marked in red, enter the 
corresponding values.

 



Depositor Layout:

These items reference fields enabled on the Depositor 
Options tab page.

Set the Horizontal Positions: Measuring from the left 
edge of the slip, to the points marked in blue, enter the 
corresponding values.

Set the Vertical Positions: Measuring from the top 
edge of the slip, to the points marked in red, enter the 
corresponding values.

Note: For fields with the 90° rotation option enabled, the 
Vertical position is the start of the text, and the Horizontal 
position in the baseline.

 

If the format is 2-sided:



These items reference fields enabled on the Basic 
Options tab page.

Set the value for Max Checks to the exact number of 
check lines on the back of the deposit slip.

Set the Horizontal Positions: Measuring from the left 
edge of the slip, to the points marked in blue, enter the 
corresponding values.

Set the Vertical Positions: Measuring from the top 
edge of the slip, to the points marked in red, enter the 
corresponding values.

 

If the format is Multi-Columned:



Follow the special instructions in the box at the bottom of the 
tab page.

This feature is primarily included in order to print to the QB 
native format, however it can be used to print to other multi-
columned slips.

The built-in format Style B uses these settings.

Back to Slip Formats
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Qslip - User Guide - Importing from QuickBooks
Prior to exporting from QuickBooks

1. (optional) When receiving checks, enter the Bank Number 
from the checks in the memo field in the "Receive 
Payments" or "Cash Sales" windows.

Qslip will read this from the QB export file.

If you have the customer list feature enabled in Qslip, you 
can skip entering the bank number here if the customer (and 
bank number) are in Qslip's customer list.

A stay-on-top customer list viewer (QSviewer) is included 
with Qslip. It can be handy to keep it open while entering 
payments received in QBooks -- a quick glance will let you 
know whether you can skip entering the bank number for a 
customer.

 

2. (optional) If you have other info that you wish to place in the memo 
field, place it after the Bank Number, separated by a comma.

Qslip will read the Bank Number from the QB export file, placing the text 
after the comma into Qslip's Memo field.

If you are not entering a bank number, place a comma before any 
memo text you wish to enter.

 

3. If you need to assign a single check to more than one payment received transaction, preface the Check Number with a "p" 



character (eg. p23081) each time it is entered. Qslip will combine the separate transactions into one check item for the deposit.

 

Export from QuickBooks

 

1. At the "Make Deposit" window, after selecting items for 
deposit, click the "Print" button.

 

2. In QB99 and above, select "Deposit summary only" when this dialog 
appears.

 



3. In the next window, select the "File" radio-button, and 
ensure "Tab delimited file" or "Comma delimited file" is the 
selection next to it.

You can use the "ASCII text file" type, but field information 
may be truncated.

4. Click "Print."

 

5. Type a name for the file to create, or select one from the 
list of files. If you always use the same name (eg. deposit.
txt), Qslip will load it on startup, saving you the extra step of 
loading it into Qslip.

6. Click "Save." (if you select a file from the list, you will 
receive a prompt asking if you want to overwrite the file - 
choose yes).

note: QuickBooks99 and prior always default to the 
QuickBooks program folder for this dialog.

 

7. The Export file has now been created, and you can run Qslip immediately (or later).



 

Import to Qslip

 

1. Run Qslip. If this is the first time, you will get an open file 
dialog. Open the file you exported from QuickBooks.

Subsequently, when you run Qslip, it will open the last file 
you had open before exiting, skipping this step.

You can also open a file at any time while Qslip is running.

 



2. The selected file (or last viewed file) is loaded into Qslip. If 
this is not the file you exported from QuickBooks, select 

"Open" from the "File" menu or click the  and use the 

dialog to open the file you exported.

Any discrepancies in the import file will be displayed in a 
warning dialog.

The import stage is complete. Now you can get 
ready to print a deposit slip.

The QuickBooks Bank Account and Deposit Total are shown 
for reference.

3. (optional) You may change the date.

4. Set the currency and coin amounts. Editing one will 
change the other, so that currency + coin = cash total.

The current slip format and printer are displayed at the 
bottom for reference. If not correct, select the proper format.

 



5. (optional) If you haven't entered some or all of the Bank or 
Check Numbers for the checks in QuickBooks, you can 
enter them now.

 

6. Print.
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Qslip - User Guide - Importing from QuickBooks Online
 

Prior to exporting from QuickBooks Online
1. Enter Bank Numbers in Memo (optional): When receiving checks, enter the Bank Number from the checks in the memo 
field in the "Receive Payments" or "Sales Receipt" screens.

Qslip will read this from the QB export file. (This feature can be disabled in preferences)

If you have the customer list feature enabled in Qslip, you can skip entering the bank number here if the customer (and bank 
number) are in Qslip's customer list.

A stay-on-top customer list viewer (QSviewer) is included with Qslip. It can be handy to keep it open while entering payments 
received in QBooks -- a quick glance will let you know whether you can skip entering the bank number for a customer.

 

2. Enter other memo text (optional): If you have other info that you wish to place in the memo field, place it after the 
Bank Number, separated by a comma.

Qslip will read the Bank Number from the QB export file, placing the text after the comma into Qslip's Memo field.

If you are not entering a bank number, place a comma before any memo text you wish to enter.

Examples:

●     16-24, memo with bank number 
●     ,memo without bank number 

 

3. Handle Split Checks (optional): If you need to assign a single check to more than one payment received transaction, 
preface the Check Number with a "p" character (eg. p23081) each time it is entered. Qslip will combine the separate transactions 
into one check item for the deposit. (This feature can be disabled in preferences)



 

Export from QuickBooks Online
You cannot create a deposit information file directly from the "Banking | Deposit" screen. First create your deposit there, then run 
a customized Deposit Detail report, export it to Excel, save to a comma-separated (CSV) file from Excel, and open that file in Qslip.

Modify Deposit Report
The default Deposit Detail report must be modified to include 
additional information (columns), which you can save for 
future use -- so this is a one-time only operation.

To create a customized report:

1.  Run the default Deposit Detail report. 



2.  Change "Transaction Date:" to "Today" (optional) 
3.  Click the "Customize..." button. 

4.  Click the "Change Columns..." button. 
�❍     Add "Account" 
�❍     Add "Payment Method" 
�❍     Verify that the following columns are included in the 

"Selected Columns:" list (others will be ignored): 
■     Date 
■     Payment Method 
■     Account 
■     Transaction Type 
■     Num 
■     Client 
■     Vendor 
■     Memo/Description 
■     Amount 

5.  Click "OK" to save the added columns. 
6.  Click "Run Report" to save the changes and rebuild the 

report. 



7.  Click "Memorize..." and give the report a name such as 
"Qslip Deposit Detail." 

8.  Click "OK" to save the report. 

 

Once you have created the custom report, the process for exporting it to a file is as follows: 

Export a Deposit Report to Excel
1.  Create and save a deposit on the "Banking | Deposit" screen. 
2.  Select "Reports | Memorized Reports", select your "Qslip Deposit Detail" report, and click "Run Report." 
3.  Verify that the deposit for which you want to print a deposit slip is in the report. If there are other deposit transactions in the report, that 

is OK -- Qslip will prompt you to select one upon import. 



4.  Click "Excel..." and either have it open directly in Excel, 
or save the file and open it manually with Excel. 

5.  With the report open in Excel, choose "Save As...". 



If you hover over Save As, a sub-menu will display. Choose 
"Other Formats." 

6.  Change the "Save as type:" to "CSV (Comma delimited) 
(*.csv)". 

7.  Choose a folder in which to save, from which you will 
open it in Qslip. 

8.  Name the file however you want. (If you use the same 
name each time, Qslip can be set to open it each time it 
starts, assign the correct slip format). 

9.  Click the "Save" button. 



 

The Export file has now been created, and you can run Qslip immediately (or later).

 

Import to Qslip
 

1. Run Qslip. If this is the first time, you will get an open 
file dialog. Open the file you exported from QuickBooks 
Online.

Subsequently, when you run Qslip, it will open the last file 
you imported, skipping this step. (This feature can be 
controlled in preferences)

You can also open a file at any time while Qslip is running.

 



If there is more than one deposit transaction in the imported 
report, a dialog will display listing each transaction.

Select the one you want and click "OK" to continue.

 

2. The file is loaded into Qslip. If this is not the file 
you exported from QuickBooks Online, select "Open" from 

the "File" menu or click the  and use the dialog to open 

the file you exported.

Any discrepancies in the import file will be displayed in a 
warning dialog.

The import stage is complete. Now you can get 
ready to print a deposit slip.

The QuickBooks Bank Account and Deposit Total are shown 
for reference.



3. Verify Date. You may change the date to when deposit 
will be made.

4. Verify Cash. Set the currency and coin amounts, if 
necessary. Editing one will change the other, so that 
currency + coin = cash total.

5. Verify Slip Format. The current slip format and printer 
are displayed at the bottom for reference. If not correct, 
select the proper format.

 

6. Add/Edit item details. (optional) If you haven't 
entered some or all of the Bank or Check Numbers for the 
checks in QuickBooks Online, you can enter them now.



 

7. Print.
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Qslip - User Guide - Importing from Other Applications
 

Qslip can also import deposit data from generic comma-separated (CSV) or tab-delimited (TXT) files. The headers and 
rules are the same for each, only the delimiter structure is different. CSV files must use double-quotes around fields 
that contain a comma character. TAB files do not require any quoting. In either case, field-enclosing quotes will be 
stripped. Headers and PmtMethod types are not case-sensitive. Order of columns is not important with one exception: 
the PmtMethod column must NOT be the last column.

A special PmtMethod type named ACCT lets you import the bank account name to which the deposit will be made, 
the deposit total and date. Put the name of the account in the DocNo column. Put the date for the deposit in the 
BankNo column (or leave blank for current date). Put the deposit total in the AMOUNT column to cause Qslip to compare 
its internally calculated total to this amount (leave blank or zero to skip). Only one row of this type should be in the 
file, otherwise only first one will be used.

The following columns and headers are required (additional columns will be ignored):

 

HEADER ACCEPTABLE DATA

PmtMethod
Must be one of CASH,COIN,CHECK,CASHBACK or ACCT

(Any other will be treated as a check with warning. See Preferences|Import Files|Payment Methods 
for more options.)

DocNo Check number (eg. 12345) or account name for ACCT

BankNo Bank number (eg. 16-49) or date (m/d/yy) for ACCT

RcdFrom Customer name (or name of check issuer)

Memo Any text



Amount Amount in format 1234.00 or 1,234.00 or $1,234.00

 

Sample CSV file

PmtMethod,DocNo,BankNo,RcdFrom,Memo,Amount 
Cash,,,Tom Jones,,163.00 
Coin,,,Larry David,,1.33 
Check,1423,12-333,Tom Jones,"This is a memo with, comma",1478.39 
Check,1638,16-49,Larry David,,"$10,989.27" 
Check,19683,17-22,Ralph Anderson,,158.94 
Cash,,,RLI Ltd,,13.44 
Check,6958887,16-9837,SBF,,"9,528.21" 
CashBack,,,,,100 
Acct,Checking,12/31/02,,,22232.58

 

Import to Qslip

 

1. Run Qslip. If this is the first time, you will get an open file 
dialog. Open the file you exported from your application.

Subsequently, when you run Qslip, it will open the last file 
you had open before exiting, skipping this step.

You can also open a file at any time while Qslip is running.



 

2. The selected file (or last viewed file) is loaded into Qslip. If 
this is not the file you exported from your application, select 

"Open" from the "File" menu or click the  and use the 

dialog to open the file you exported.

Any discrepancies in the import file will be displayed in a 
warning dialog.

The import stage is complete. Now you can get 
ready to print a deposit slip.

If you included an ACCT row in the file, The Bank Account 
and Deposit Total are shown for reference.



3. (optional) You may change the date.

4. Set the currency and coin amounts. Editing one will 
change the other, so that currency + coin = cash total.

The slip format is displayed at the bottom for reference. If 
this is not correct, select the proper format.

 

5. (optional) If some or all of the Bank or Check Numbers for 
the checks were not in the deposit data, you can enter them 
now.



 

6. Ensure the correct Slip Format is selected.

7. (first time only) Setup your deposit slip layout and adjust it for printing.

8. Print.

Back to Table of Contents
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Qslip - User Guide - Import Optimizing

1.  Enter Bank Numbers from checks in the memo field in QuickBooks. 
2.  Use the same filename each time you export a deposit. 
3.  Name the export file with a name that matches the Slip Format's "Filename that will have this format assigned." 

 
Qslip will load the file on startup and apply the correct Slip Format. All you will have to do is place a blank 
deposit slip in your printer, possibly edit the coin & currency amounts, click "Print" in Qslip - and you're done! 
 

4.  Pass files on the command line. (more info...) 

Copyright Qtools Software - © all rights reserved

QuickBooks is a registered trademarks of Intuit, Inc.



Back to Table of Contents

Qslip - User Guide - Import Errors
●     Qslip checks import files for errors and integrity, and warns of any findings. 
●     If any of the User Actions does not solve your problem contact Qtools Support. 

QuickBooks

ERROR Qslip Action User Action

Invalid (or corrupt) file format. file will not be imported. Export the deposit from QuickBooks again.

Any items not Cash or Check (eg. 
VISA, etc.).

file will be imported so that you can note 
problem item(s).

Correct the error in QuickBooks and export 
the deposit again.

Deposit total given by import file does 
not match actual total of items.

file will be imported so that you can note 
problem item(s).

Export the deposit again.

There are more checks in the import 
file then the number allowed in the 
Max Checks setting in Qslip

file will be imported so that you can change 
settings, or note error for correction in 
QuickBooks.

Select a Slip Format that will handle the 
number of checks. 
 

-or-

Edit the deposit in QuickBooks and reduce 
the number of checks, then export it again.

Back to Table of Contents
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Qslip - User Guide - Setting the Slip Format
Select a format from the drop-down list.

The "Filename that will have this format assigned" lets you 
assign the displayed format to import files using that name 
plus any extension (such as ".txt").

Any changes to the format settings on this tab page and the 
subsequent options and layout pages apply to the currently 
selected Slip Format, and are automatically saved before 
selecting another format, previewing, printing or closing 
Qslip.

To create a new slip format, enter a new name or click the 
"Create New Format" button, then...

Creating New Formats



To create a new format based on values from an existing 
format, select that option, enter a name for the new slip, 
select the format to copy and click "OK".

-OR-

 



To create a new slip format, starting with default values, 
select that option, enter a name for the new slip and click 
"OK".

 

Next: Set the Layout Options your deposit slip layout.

Back to Slip Formats
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Qslip - User Guide - Testing Layout & Options Settings
 

Use this testing method when printing to pre-printed deposit slips.

 

Test the individual field positions 
1.  Print a deposit slip with real or dummy data (either a sample included with Qslip, or a deposit of your own) to 

standard 8.5" x 11" paper. 
2.  Place a blank pre-printed deposit slip over the standard sheet. 
3.  Hold up to the light, align the date field, and note positions of other items. 
4.  Make adjustments to field positions values as necessary and retest. 

Test the overall alignment

If printer feeds deposit slips in center (most laser printers):

1.  Fold the standard sheet vertically in half. 
2.  Fold the blank pre-printed deposit slip in half vertically. 
3.  Place the slip over the standard sheet, aligning the folds and the top edges. 
4.  Hold up to the light and note positions. 
5.  Make adjustments to the Vertical and Horizontal alignment values as necessary and retest. 

If printer feeds deposit slips at one side (many inkjet printers):

1.  Depending upon which side the printer feeds, either set the Horizontal Adjustment value to near zero, or a 
value that will shift the slip image to the other side of the page. 

2.  Make adjustments to the Vertical and Horizontal alignment values as necessary and retest. 

Print a test to a blank pre-printed deposit slip

1.  Check alignment and adjust as necessary. 



Back to Slip Formats
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Qslip - User Guide - Example

Let's say you have 2 bank accounts, one with Wells Fargo and the other with Bank One. The deposit slips are 
different. In addition, you want the option to use either of 2 printers.

1.  Click the "new" button on the "Slips" tab of Slip Format setting section to create a new slip format in Qslip to 
match the first bank account's pre-printed deposit slip, if it isn't among those included with Qslip, using the first 
printer. Name the slip format descriptively, such as "WellsFargo-HP5L". 

2.  Enter a short, descriptive name in the "Filename that will have this format assigned" box, such as "depwf5l". 
3.  Set the Layout Options and Positions. 
4.  Once you have it printing properly, click the "new" button again, name the new slip format to identify that it will 

use a different printer, such as "WellsFargo-Epson6000"; choose the option to "Copy values from any existing 
format to a new one" and select the new slip format you created above; change the file assignment name to, 
for example, "depwfe6"; change the printer on the "Add'l Options" tab to the second printer; test the settings 
since you might need to adjust the side 1 and side 2 alignment. 

5.  Repeat items 1 - 4 above for the second bank account, using "BankOne" in place of "WellsFargo" for the 
format names, and something like "depb1..." for the file assignment names. 

You now have 4 custom slip formats that can be assigned to import files, simply by naming the file appropriately 
(e.g. depwf5l.txt) during export from the accounting applications such as QuickBooks. When you open the file in 
Qslip, the correct slip format (and printing device) will be assigned.

Remember, you can always print the current deposit info with any available slip format by selecting it from the 
drop down list on the "Slips" tab of the "Slip Format" section.

Copyright Qtools Software - © all rights reserved

QuickBooks is a registered trademarks of Intuit, Inc.































Back to Table of Contents

Qslip - User Guide - Printing on Plain Paper

1.  Ensure the current Slip Format is one that uses a Slip Background to print the entire ticket. (There are several 
built-in formats that can be used as-is, or copied and modified). 
See the Depositor Options setup page for more information about printing your bank and account information 
on the deposit slip.

2.  Printing will use the printer's default tray or bypass tray, which should be loaded with plain paper of the 
appropriate size. Standard letter size (8.5x11) is recommended.

3.  If it is a 2-sided deposit slip, set the "Print Sides" option: 
�❍     Both: Qslip will prompt you to reinsert the deposit slip in order to print side 2.
�❍     Side1 or 2: Prints the selected side only.
�❍     Duplex H2H: Auto-duplexing printers are set head-to-head duplex.
�❍     Duplex H2T: Auto-duplexing printers are set head-to-toe duplex.

4.  Click "Print" in Qslip.

(optional) If the preview window is not visible, click the 
"Preview" button to see the deposit slip as it will be printed.



Back to Table of Contents

Copyright Qtools Software - © all rights reserved

QuickBooks is a registered trademarks of Intuit, Inc.



Back to Table of Contents

Qslip - User Guide - Printing on Pre-printed Deposit Slips

1.  Place a blank pre-printed deposit slip in the envelope bypass or any adjustable tray of your printer and adjust 
the guides to fit your slip.

2.  If it is a 2-sided deposit slip, set the "Print Sides" option: 
�❍     Both: Qslip will prompt you to reinsert the deposit slip in order to print side 2.
�❍     Side1 or 2: Prints the selected side only.
�❍     Duplex H2H*: Auto-duplexing printers are set head-to-head duplex.
�❍     Duplex H2T*: Auto-duplexing printers are set head-to-toe duplex. 

(*not recommended for small pre-printed deposit slips)

3.  Click "Print" in Qslip.

(optional) Prior to printing, if the preview window is not 
visible, click the "Preview" button to see the deposit 
information as it will be printed. Text in red on the preview 
does not print on the slip -- it's just for reference.
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